
After completing this lesson, you will be able to:
1. Open an existing document.

2. Enter formatting characters.

3. Move within a document.

4. Undo and Redo actions.

5. Repeat actions.

6. Select text.

7. Save a revised document.

8. Work with document properties.

OBJECTIVES

 Estimated Time: 11/4 hours

Lesson 2

Selecting 
and Editing

To edit documents efficiently, you need to learn to select text and move 
quickly within a document. In this lesson you learn those skills, as well as 
how to open and save an existing document.

Opening an Existing Document
Instead of creating a new document, you start this lesson by opening an 
existing document. There are several ways to open a document:

• Choose Open from the File menu.

• Press Ctrl � O .

•  Use the document links in the Recent Documents file listing.

 OBJECTIVE 1 OBJECTIVE 1

MCAS OBJECTIVES

In this lesson:
WW 07 1.3.3
WW 07 6.1.1
WW 07 6.1.2

WD-26

PREPARE
Point out to students that the 
learning objectives show what 
they will learn in the lesson. Each 
heading in the lesson correlates to 
a learning objective.
Required Files: Campbell-1

TEACH
Teaching Resources:
This text is supported by classroom 
presentations in a PowerPoint 
format. For this lesson, use In 
Word Classroom Presentation 2.

The Quick Access Toolbar 
can be customized to include 
an Open button. You may 
want to show students how 
to add the Open button to the 
Quick Access Toolbar.
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TIP

The keyboard shortcut to open the File 
menu is Alt � F .

Figure 2-1
Files listed in the 
Open dialog box

 Exercise 2-1     OPEN AN EXISTING FILE

  1.  Click the Microsoft Office Button to open the File 
menu. The file names listed under Recent Documents 
are the files opened from this computer. If the file 
you want is listed, you can click its name to open 
it from this list. The Recent Documents section 
displays up to 17 documents.

  2.  Click Open to display the Open dialog box. You are 
going to open a student file named Campbell-1.

  3.  Locate the appropriate drive and folder according to 
your instructor’s directions.

NOTE

Click Folders to open and close the 
Folders list.

Address bar shows 
current location

Click to open and 
close the Folders list

Navigation pane

WD-27

Important: Make sure students know 
where and how to access files. You may 
also want to discuss the search tools 
available in the Open dialog box as well 
as using the headings to sort files. You 
can protect loaded data files by setting 
the read-only attribute.

c Word Classroom Presentation 2.

c

The student data files are 
available at the following Web 
site: www.mhhe.com/pas07/brief
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Figure 2-2
Views menu in the 
Open dialog box

  6.  From the list of file names, locate Campbell-1 and 
click it once to select it.

  7. Click Open.

You can also double-click a file name to open a file.

 4.  After you locate the student files, click the arrow next to the Views 
button  in the Open dialog box to display a menu of view 
options.

 5.  Choose List to list all files by file name.

Drag to 
change view

NOTE

Documents created in earlier versions 
of Word display Compatibility Mode in 

the Title bar when opened. Compatibility 
Mode enables you to open, edit, and 

save documents that were created using 
earlier versions of Word. New features 

in Office Word 2007 are not available in 
Compatibility Mode. To check for features 

not supported by earlier versions of the 
Word program, click the Microsoft Office 

Button, and click the arrow beside Prepare. 
Click Run Compatibility Checker. To 

convert a document created in an earlier 
version of Word to Office Word 2007, 

click the Microsoft Office Button, and click 
Convert. Click OK.

WD-28 UNIT 1 Basic Skills

c

Word Classroom Presentation 2.c

To open the Preview pane, click the down arrow beside 
Organize, click Layout, and click Preview pane.

Documents created in earlier versions of Word can be converted to Office 
Word 2007. Click the Microsoft Office Button, and click Convert. Click OK in 
the Microsoft Office Word dialog box. Save the document.

You may want to show students how to open a document created in an 
earlier version of Word and to point out the Compatibility Mode notation in 
the Title bar. Show them how to use the Run Compatibility Checker feature.
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Exercise 2-2     CREATE A NEW FOLDER

Document files are typically stored in folders that are part of a hierarchal 
structure similar to a family tree. At the top of the tree is a disk drive letter 
(such as C: or A:) that represents your computer, network, floppy drive, jump 
drive, or CD-ROM drive. Under the disk drive letter, you can create folders to 
organize your files. These folders can also contain additional folders.

Here is a scenario: You store your files on the C: drive of your office 
computer. You create a folder on this drive named “Word Documents.” Within 
this folder you create folders named “Letters,” “Memos,” and “Reports,” each 
containing different types of documents.

For this course, you will create a new folder for each lesson and store 
your completed exercise documents in these folders.

 1.  Click the Microsoft Office Button and choose Save As. You are going 
to save Campbell-1 under a new file name, in a new folder that will 
contain all the files you save in this lesson.

 2.  Choose the appropriate drive and folder location from the Navigation 
pane. (For example, to save your files to a jump drive, insert a jump 

TABLE 2-1 Open Dialog Box Buttons

Button  Name Purpose

 Address bar Navigates to a different folder.

 Back button  Works with the Address bar, and returns 
to most recent previous location.

 Forward button  Works with the Address bar, and 
returns to location already opened.

 Search box Looks for a file or subfolder.

 Organize  Opens a menu of file functions, such as 
cutting a file, copying a file, pasting a file, 
deleting a file, or renaming a file. Includes 
the Layout option to display the Navigation 
pane, Details pane, and the Preview pane.

 Views  Opens a menu of view options for 
displaying drives, folders, files, and 
their icons.

  New Folder  Creates a new folder to organize your files.

This is a good opportunity to discuss the benefits of 
good file management habits. Losing track of files is 
easy, but a sensible folder structure can minimize the 
risk. Open Windows Explorer, and demonstrate some 
basic strategies for creating folders and subfolders that 
can make it easier to remember where specific files 
are stored.

Students will create a new folder for their Lesson 2 files. They will create 
lesson folders from this point on in the course, to develop good file 
management habits. Tell students where to locate these folders (on the 
hard disk, jump drive, or network). Make sure they know how to specify 
the location in the Navigation pane. Additionally, you might want students 
to create a Lesson 1 folder and show them how to move their Lesson 1 
files into this folder, using drag-and-drop techniques in Windows Explorer.
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drive in the USB port, and make sure the Address bar indicates the 
appropriate drive).

  3.  Click the Create New Folder button . A New Folder icon 
appears in the File list section.

  4.  Key the folder name [your initials]Lesson2 and 
press Enter . The folder name appears in the Address 
bar and in the Navigation pane. Word is ready to 
save the file in the new folder.

  5.  Locate the File name box, and make sure the file’s 
original name (Campbell-1) is selected. If not, 
double-click it.

  6. Key the file name [your initials]2-2 and click Save.

Formatting Characters
The Show/Hide ¶ button  on the Home tab shows or hides paragraph 
marks and other formatting marks. These characters appear on the screen, 
but not in the printed document. Formatting marks are included as part of 
words, sentences, and paragraphs in a document. Here are some examples:

• A word includes the space character that follows it.

•  A sentence includes the end-of-sentence punctuation and at least 
one space.

• A paragraph is any amount of text followed by a paragraph mark.

The document you opened contains two additional formatting characters: 
tab characters, which you use to indent text, and line-break characters, which 
you use to start a new line within the same paragraph. Line-break characters 
are useful when you want to create a paragraph of short lines, such as an 
address, and keep the lines together as a single paragraph.

Another formatting character is a nonbreaking space, which you use to 
prevent two words from being divided between two lines. For example, you 
can insert a nonbreaking space between “Mr.” and “Smith” to keep the name 
“Mr. Smith” undivided on one line.

 OBJECTIVE 2 OBJECTIVE 2

NOTE

To rename a folder, locate the folder to 
rename and right-click the folder. Click 
Rename on the shortcut menu, key the 

new name, and press Enter .

The solution file 2-2 in the 
Solutions Manual and on 
the Solutions Disk is the 
final file saved in Exercise 
2-12, after all the editing has 
taken place. This is because 
students learn to use the Save 
command in Exercise 2-12, 
not the Save As command 
they already know.

Objective 2 
Assignment:
Exercise 2-16 
(Skills Review) can 
be assigned after 
completing Objective 2.

The Show/Hide button may 
not hide all formatting marks. 
You can choose to display all 
or selected formatting marks 
to display at all times. To turn 
on or turn off the display of 
formatting marks, click the 
Microsoft Office Button and 
click Word Options. Click 
Display to select an option to 
display at all times.

Point out the tab 
characters in this 
document, and briefly 
explain their use.
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TABLE 2-2 Formatting Characters

Character To Insert, Press

Tab (→) Tab

Space (.) Spacebar

Nonbreaking space (°) Ctrl � Shift � Spacebar

Paragraph mark (¶) Enter

Line-break character (↵) Shift � Enter

Figure 2-3
Formatting 
characters

Exercise 2-3 ENTER FORMATTING CHARACTERS

 1.  Click the Show/Hide ¶ button  if the formatting characters in the 
document are hidden.

 2.  Move the insertion point to the end of the document (after “family 
recipes.”).

 3.  Press Enter  to begin a new paragraph, and key Campbell’s Confections 
has been a member in good standing of the NCA for over 50 (do not 
press Spacebar ).

 4.  Insert a nonbreaking space after “50” by pressing Ctrl � Shift � Spacebar . 
Then key years. (including the period). Word now treats “50 years” as 
a single unit.

Tab character

Paragraph
mark

Nonbreaking
space

Space 
character

Line break 
character

c

Word Classroom Presentation 2.c
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  5.  Press Enter  and key the following text as one 
paragraph at the end of the document, pressing 
Shift � Enter  at the end of the first and second lines 
instead of Enter . 

 Campbell’s Confections 
 25 Main Street 
 Grove City, PA 16127

  6.  Click the Show/Hide ¶ button  to hide the formatting characters, 
and click it again to redisplay them.

Moving within a Document
You already know how to move around a short document by positioning the 
I-beam pointer with the mouse and clicking. This is the easiest way to move 
around a document that displays in the document window. If a document is 
too long or wide to view in the window, you need to use different methods to 
navigate within a document.

Word offers two additional methods for moving within a document:

•  Using the keyboard: You can press certain keys on the keyboard to move 
the insertion poin t. The arrow keys, for example, move the insertion 

point up or down one line or to the left or right 
one character. Key combinations quickly move the 
insertion point to specified locations in the document.

•  Using the scroll bars: Use the vertical scroll bar at the 
right edge of the document window to move through 
a document. The position of the scroll box indicates 
your approximate location in the document, which 
is particularly helpful in long documents. To view 
and move through a document that is wider than the 
document window, use the horizontal scroll bar at the 
bottom of the document window.

Exercise 2-4  USE THE KEYBOARD TO MOVE 
THE INSERTION POINT

 1.  Press Ctrl � Home  to move to the beginning of the document. Press End  
to move to the end of the first line.

 OBJECTIVE 3 OBJECTIVE 3

NOTE

A smart tag may appear in the address. 
Word applies smart tags (nonprinting, 

purple dotted underlines) to address text.

NOTE

Scrolling through a document does not 
move the insertion point. It moves only 
the portion of the document you are 

viewing in the document window. When 
you use the keyboard to move within 

a document, the insertion point always 
moves to the new location.

Line-break characters might be confusing at this point. 
After students learn how to select text, have them 
practice selecting the paragraphs that contain line 
breaks. Manual line breaks are often used when a 
paragraph style has extra space before the paragraph 
and you don’t want short lines of text to include that 
extra space.

Demonstrate that scrolling through 
a document does not move the 
insertion point. This can be difficult 
for students to understand. They 
often scroll through a document 
and then attempt to enter text in 
the visible portion of the document 
although the insertion point has not 
moved.

Objective 3 Assignment:
Exercise 2-17 (Skills Review) 
can be assigned after 
completing Objective 3.
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TABLE 2-3 Keys to Move the Insertion Point

To Move Press

One word to the left Ctrl �

One word to the right Ctrl �

Beginning of the line Home

End of the line End

One paragraph up Ctrl �

One paragraph down Ctrl �

Previous page Ctrl � PageUp

Next page Ctrl � Page Down

Up one window PageUp

Down one window Page Down

Top of the window Alt � Ctrl � Page Up

Bottom of the window Alt � Ctrl � PageDown

Beginning of the document Ctrl � Home

End of the document Ctrl � End

  2.  Press Ctrl �  several times to move the insertion 
point down one paragraph at a time. Notice how 
the text with the line-break characters is treated as a 
single paragraph.

  3.  When you reach the end of the document, press 
Page Up  until you return to the beginning of the 
document.

TIP

Word remembers the last three locations 
in the document where you edited or 
keyed text. You can press Shift � F5  
to return the insertion point to these 

locations. For example, when you open 
a document you worked on earlier, press 

Shift � F5  to return to the place where you 
were last working before you saved and 

closed the document.

Exercise 2-5  SCROLL THROUGH A DOCUMENT

Using the mouse and the scroll bars, you can scroll up, down, left, and right. 
You can also set the Previous and Next buttons on the vertical scroll bar to 
scroll through a document by a specific object, such as tables or headings. 
For example, these buttons let you jump from one heading to the next, going 
forward or backward.

Remind students that using the keyboard can be faster than 
using the mouse when moving through a document because 
you don’t have to take your hands away from the keyboard.

Table 2-3 is especially helpful for anyone who has keyboarding 
skills. Suggest that students practice these skills.

hin1926X_ch02_WD026-WD047.indd Page WD-33  10/5/08  10:13:54 AM user-s205 /Volumes/207/MHBR074/work%/indd%0/word%0



UNIT 1 Basic Skills
W

or
d 

20
07

WD-34

 1.  Locate the vertical scroll bar, and click below the scroll box to move 
down one window.

  2. Drag the scroll box to the top of the scroll bar.

  3.  Click the down scroll arrow  on the scroll bar 
three times. The document moves three lines.

  4.  Click the right scroll arrow  on the horizontal 
scroll bar once, and then click the left scroll arrow 

 once to return to the correct horizontal position.

  5.  Click the up scroll arrow  on the vertical scroll 
bar three times to bring the document back into 
full view. 
Notice that as you scroll through the document, the 
insertion point remains at the top of the document.

  6.  Click the Select Browse Object button , located 
toward the bottom of the vertical scroll bar. A menu 
of icons appears.

TIP

The keyboard shortcut to display 
the Select Browse Object menu is 

Ctrl � Alt � Home .

NOTE

The horizontal scroll bar does not display 
if the document window is wide enough 
to display the document text. To display 
the horizontal bar, size the window by 
dragging the resize handle (located in 

the lower right corner) to the left. When 
you resize the document window, the 
appearance of the Ribbon changes.

Figure 2-4
Using the scroll bars

Scroll box

Right scroll 
arrow

Scroll boxHorizontal scroll 
bar

Left scroll arrow

Down scroll 
arrow

Previous

Vertical 
scroll bar

Up scroll 
arrow

Select Browse
Object

Next

It may be necessary to resize the document window to display the horizontal scroll bar. Show students 
how to use the resize handle to resize the document to display the horizontal scroll bar.

Word Classroom 
Presentation 2.c

c
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  7.  Move the pointer over each icon to identify it. These browse options 
become significant as your documents become more complex. Click 
the Browse by Page icon .

TABLE 2-4 Scrolling through a Document

To Move Do This

Up one line Click the up scroll arrow .

Down one line Click the down scroll arrow .

Up one window Click the scroll bar above the scroll box.

Down one window Click the scroll bar below the scroll box.

To any relative position Drag the scroll box up or down.

To the right Click the right scroll arrow .

To the left Click the left scroll arrow .

Into the left margin Hold down Shift  and click the left scroll arrow .

Up or down one page  Click Select Browse Object , click Browse by Page , and then 
click next  or previous .

TIP

If you are using a mouse with a wheel, 
additional navigating options are available. 
For example, you can roll the wheel forward 

or backward instead of using the vertical 
scroll bars, hold down the wheel and drag in 
any direction to pan the document, or hold 
down Ctrl  as you roll the wheel to change 

the magnification.

Undo and Redo Commands
Word remembers the changes you make in a document and lets you undo or 
redo these changes. For example, if you accidentally delete text, you can use 
the Undo command to reverse the action and restore the text. If you change 
your mind and decide to keep the deletion, you can use the Redo command 
to reverse the canceled action.

There are two ways to undo or redo an action:

•  Click the Undo button  or the Redo button  on the Quick Access 
Toolbar.

• Press Ctrl � Z  to undo or Ctrl � Y  to redo.

 OBJECTIVE 4 OBJECTIVE 4

Efficient scrolling is a necessary word 
processing skill. Have students practice 
scrolling through a document, using all the 
methods discussed in Table 2-4.

The Select Browse Object button is more meaningful when the document is long 
or contains headings, graphics, tables, fields, or sections. Tell students the Browse 
Object menu also contains an icon to browse by edits. When you choose this option, 
the Previous and Next buttons become the Previous Edit and Next Edit buttons.
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Exercise 2-6 UNDO AND REDO ACTIONS

 1.  Delete the first word in the document, “Campbell’s,” by moving the 
insertion point to the right of the space after the word and pressing 
Ctrl � Backspace . (Remember that a word includes the space that 
follows it.)

 2.  Click the Undo button  to restore the word.

 3.  Move the insertion point to the left of the word “candy” in the first 
paragraph.

 4.  Key mid-size and press Spacebar  once. The text now reads “mid-size 
candy manufacturer.”

 5. Press Ctrl � Z . The word “mid-size” is deleted.

 6.  Click the Redo button  to restore the word “mid-size.”

 7.  Click the down arrow to the right of the Undo button . Word 
displays a drop-down list of the last few actions, with the most 
recent action at the top. You can use this feature to choose several 
actions to undo rather than just the last action. Click the down 
arrow again to close the list.

 8. Click the Undo button .

Figure 2-5
Undo Drop-Down list

Repeat Command
Suppose you key text you want to add to other areas of a document. Instead of 
rekeying the same text, you can use the Repeat command to duplicate the text.

To use the Repeat command:

• Press Ctrl � Y  or

• Press F4 .

 OBJECTIVE 5 OBJECTIVE 5

Make sure students feel comfortable using the Undo button. 
Stress that it should be clicked immediately after an action 
they want to undo. Being able to undo a mistake often relieves 
anxiety for students who are new to word processing.

Tell students Redo only “undoes an 
Undo.” It does not repeat any other 
kind of action. The Repeat command 
is discussed in Exercise 2-7.

c Word Classroom 
Presentation 2.

c
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Exercise 2-7 REPEAT ACTIONS

 1.  In the first paragraph position the insertion point to the left of the 
word “candy.”

  2.  Key popular and press Spacebar  once. The sentence now 
begins “Campbell’s Confections is a popular candy.”

  3.  Move the insertion point to the left of the word 
“selections” in the paragraph that begins “Visit one 
of our.”

  4. Press F4  and the word “popular” is repeated.

Selecting Text
Selecting text is a basic technique that makes revising documents easy. 
When you select text, that area of the document is called the selection, and it 
appears as a highlighted block of text. A selection can be a character, group 
of characters, word, sentence, paragraph, or the whole document. In this 
lesson, you delete and replace selected text. Future lessons show you how to 
format, move, copy, delete, and print selected text.

You can select text several ways, depending on the size of the area you 
want to select.

 OBJECTIVE 6 OBJECTIVE 6

NOTE

If you want to undo, redo, or repeat 
your last action, do so before you press 

another key.

TABLE 2-5 Mouse Selection

To  Use the Mouse to Select

A series of characters  Click and drag, or click one end of the text block, and 
then hold down Shift  and click the other end.

A word Double-click the word.

A sentence Press Ctrl  and click anywhere in the sentence.

A line of text  Move the pointer to the left of the line until it changes 
to a right-pointing arrow, and then click. To select 
 multiple lines, drag up or down.

A paragraph  Move the pointer to the left of the paragraph and 
double-click. To select multiple paragraphs, drag up or 
down.

The entire document  Move the pointer to the left of any document text until 
it changes to a right-pointing arrow, and then triple-click 
(or hold down Ctrl  and click).

Explain that the Repeat command 
only repeats the last command or 
action issued. It does not repeat 
multiple commands or actions.

Objective 6 Assignment:
Exercises 2-18 (Skills Review), 2-20, 2-21, 2-22 
(Lesson Applications) and 2-25 (On Your Own) 
can be assigned after completing Objective 6.

Demonstrate selecting text with the 
mouse. Tell students a “selection” is also 
commonly called a “block.” Make sure 
students know how to cancel a selection.
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Exercise 2-8 SELECT TEXT WITH THE MOUSE

 1.  Select the first word of the document by double-clicking it. Notice 
that the space following the word is also selected.

Figure 2-6
Selecting a word

  2.  Cancel the selection by clicking anywhere in the 
document. Selected text remains highlighted until 
you cancel the selection.

  3.  Select the first sentence by holding down Ctrl  and 
clicking anywhere within the sentence. Notice that 
the period and space following the sentence are part 
of the selection. Cancel the selection.

   4. Locate the paragraph that begins “Visit one of our.”

    5.  To select the text “milk chocolate,” click to the left of 
“milk.” Hold down the left mouse button and slowly 
drag through the text, including the comma and 
space after “chocolate.” Release the mouse button. 
Cancel the selection.

  6.  To select the entire paragraph by dragging the 
mouse, click to position the insertion point to the 
left of “Visit.” Hold down the mouse button, and 
then drag across and down until all the text and the 
paragraph mark are selected. Cancel the selection.

     7.  Select the same paragraph by moving the pointer 
into the blank area to the left of the text “Visit.” 
(This is the margin area.) When the I-beam pointer 
changes to a right-pointing arrow , double-click. 
Notice that the first click selects the first line and 
the second click selects the paragraph, including the 
paragraph mark. Cancel the selection.

NOTE

When text is selected, a Mini toolbar 
appears with formatting options.

TIP

When selecting more than one word, you 
can click anywhere within the first word, and 

then drag to select additional text. Word 
will “smart-select” the entire first word.

TIP

You can also triple-click within a 
paragraph to select it.

c

c Word Classroom 
Presentation 2.

Have students test 
Word’s “smart select” 
capability by dragging 
from midword to select 
two consecutive words.

Students might need to practice moving the pointer in the margin 
area to display the right-pointing arrow. If the pointer does not point 
to the right, text cannot be selected as described. Have the students 
move the pointer around and observe how it changes shape.

Remind students that when text is selected using the margin area, 
the selection must be canceled within the text area, not in the 
margin area.

Remind students that the 
position of the pointer 
determines which line is 
selected. To select the first 
line, the pointer must be to 
the left of the line.
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Exercise 2-9 SELECT NONCONTIGUOUS TEXT

In the previous exercise, you learned how to select contiguous text, where the 
selected characters, words, sentences, or paragraphs follow one another. But 
sometimes you would like to select noncontiguous text, such as the first and 
last items in a list or the third and fifth word in a paragraph. In Word, you can 
select noncontiguous text by using Ctrl  and the mouse.

 1. Select the first line of the list (“retail”).

 2.  Press Ctrl  and select the third line of the list (“fundraising”). With 
these two separate lines selected, you can delete, format, or move 
them without affecting the rest of the list.

 3.  Cancel the selection and go to the paragraph that begins “Visit one 
of our.”

 4.  In the paragraph that begins “Visit one of our,” double-click the word 
“our” before “Web site.” With the word now selected, hold down Ctrl  
as you double-click the word “popular” in the same sentence and 
“finest” in the next sentence. (See Figure 2-8.) All three words are 
highlighted.

Figure 2-7
Selecting text

Point and double- 
click to select 

paragraph.

c

c Word Classroom 
Presentation 2.

Students might have trouble understanding the 
usefulness of selecting noncontiguous text. Using 
step 4 as an example, tell students this selection 
method would be handy if the user wanted to 
italicize all three words. Now they can all be 
made italic in one step.
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 5. Cancel the selection.

Figure 2-8
Selecting 

noncontiguous 
words

Exercise 2-10  ADJUST A SELECTION USING THE 
MOUSE AND THE KEYBOARD

 1. Select the paragraph beginning “Visit one of our.”

 2.  Hold down Shift  and press  until the last sentence is no longer 
highlighted. Release Shift .

 3.  Increase the selection to include the last sentence by holding down 
Shift  and pressing End  and then pressing . Release Shift .

 4.  Increase the selection to include all the text below it by holding 
down Shift  and clicking at the end of the document (after the 
Zip Code).

 5.  Select the entire document by pressing Ctrl � A . Cancel the selection.

c

c Word 
Classroom 
Presentation 2.

Another way to extend a text selection is to turn 
on Selection mode by pressing F8 . In Selection 
mode, you can press F8  to select a word, press 
it again to select a sentence, press it again to 
select a paragraph, and press it again to select the 
entire document. Press Shift � F8  to shorten the 
selection. Press Esc  to turn off Selection mode. 
Right-click the status bar and click Selection Mode 
to turn on or turn off the status bar indicator.

Demonstrate how using the mouse for selecting is 
not always the most effective approach and that 
sometimes the mouse selection must be adjusted 
using the keyboard. You can demonstrate the 
difficulty of selecting single characters or multiple 
paragraphs that extend beyond the portion of the 
document appearing on the screen.
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Exercise 2-11  EDIT TEXT BY REPLACING 
A SELECTION

You can edit a document by selecting text and deleting or replacing the 
selection.

      1.  Locate the paragraph that begins “Visit one of 
our,” select the words “our popular” using the 
Shift �click method: Click to the left of the word 
“our,” hold down Shift , and click to the right of the 
word “popular.”

  2. Key the variety of to replace the selected text.

  3.  Locate the paragraph that begins “Campbell’s 
Confections has been,” select “NCA” and key 
National Confectioners Association. Notice that, 
unlike using Overtype mode, when you key over 
selected text, the new text can be longer or shorter 
than the selection.

TABLE 2-6 Keyboard Selection

To Select Press

One character to the right Shift �

One character to the left Shift �

One word to the right Ctrl � Shift �

One word to the left Ctrl � Shift �

To the end of a line Shift � End

To the beginning of a line Shift � Home

One line up Shift �

One line down Shift �

One window down Shift � PageDown

One window up Shift � Page Up

To the end of a document Ctrl � Shift � End

To the beginning of a document Ctrl � Shift � Home

An entire document Ctrl � A

NOTE

Although keying over selected text is an 
excellent editing feature, it sometimes 

leads to accidental deletions. Remember, 
when text is selected in a document 

(or even in a dialog box) and you begin 
keying text, Word deletes all the selected 
text with your first keystroke. If you key 
text without realizing a portion of the 
document is selected, use the Undo 

command to restore the text.
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Exercise 2-12  SAVE A REVISED 
DOCUMENT

  1.  Click the Save button  on the Quick Access 
Toolbar. This action does not open the Save As 
dialog box.

  2.  Open the File menu and point to the arrow beside Print. Click Quick 
Print to print the document.

Exercise 2-13  CHECK WORD’S AUTORECOVER 
SETTINGS

Word’s AutoRecover feature can automatically save open documents at an 
interval you specify. However, this is not the same as saving a file yourself, 
as you did in the preceding exercise. AutoRecover’s purpose is to save 
open documents “in the background,” so a recently saved version is always 
on disk. Then if the power fails or your system crashes, the AutoRecover 
version of the document opens automatically the next time you launch 
Word. In other words, AutoRecover ensures you always have a recently saved 
version of your document.

Even with AutoRecover working, you need to manually save a document 
(by using the Save command) before closing it. AutoRecover documents are 
not always available; if you save and close your file normally, the AutoRecover 
version is deleted when you exit Word. Still, it is a good idea to make sure 
AutoRecover is working on your system and to set it to save recovery files 
frequently.

 1.  Open the File menu and click Word Options to open the Word 
Options dialog box.

 2.  Click Save in the left pane.

 3.  Make sure the Save AutoRecover information every box is checked. If it 
is not checked, click the box.

 4. Click the up or down arrow buttons to set the minutes to 5. 
Click OK.

NOTE

If you wanted to save the current 
document with a different file name, you 

would use the Save As command.

Saving a Revised Document
You have already used the Save As command to rename the document you 
loaded at the beginning of this lesson. Now that you have made additional 
revisions, you can save a final version of the document by using the Save 
command. The document is saved with all the changes, replacing the old file 
with the revised file.

 OBJECTIVE 7

Word offers many helpful Save options, available by clicking the 
Microsoft Office Button, clicking Word Options, and clicking Save. 
(You can also click Tools in the Save As dialog box and click Save 
Options). In addition to AutoRecover, covered in Exercise 2-13, you 
can specify the format used for saving Word documents.

Discuss saving a document using the Word 97-2003 
Document format to ensure compatibility with previous 
versions of Word.
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Figure 2-9
Setting AutoRecover 

options

Click to 
select

Working with Document Properties
Information that describes your document is called a property. Word 
automatically saves your document with certain properties, such as the file 
name, the date created, and the file size. You can add other properties to 

a document, such as the title, subject, author’s name, and 
keywords. This information can help you organize and 
identify documents.

 OBJECTIVE 8

Exercise 2-14  REVIEW AND EDIT DOCUMENT 
PROPERTIES

 1.  With the file [your initials]2-2 still open, open the File menu and 
click Prepare. Click Properties. The Document Information panel 
opens above your document.

NOTE

You can also search for documents based 
on document properties by using the 

Search feature.

c

c Word Classroom 
Presentation 2.

Objective 8 Assignment:
Exercises 2-19 (Skills Review), 2-23 (Lesson 
Applications), and 2-24 and 2-26 (On Your Own) 
can be assigned after completing Objective 8.
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 2.  Notice the document properties displayed in the Document 
Information Panel.

Figure 2-10
Displaying document 

properties

Figure 2-11
Document 

Information Panel

 3.  Click the Property Views and Options button . Click 
Advanced Properties. Click the General tab. This tab displays basic 
information about the file, such as file name, file type, location, size, 
and creation date.

 4.  Click the Statistics tab. This tab shows the exact breakdown of the 
document in number of paragraphs, lines, words, and characters.

c

The Required field flag appears only with 
properties that are bound to documents 
that are stored on property management 
servers. Built-in properties are not required.

When students display the Summary tab, 
information might already be entered in the Author 
or Company text boxes, depending on how Word 
was installed on their computers. For example, the 
school name might appear in the Company text box.

Word Classroom 
Presentation 2.c

c
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 5.  Click the Summary tab. Here you can enter specific document 
property information or change existing information.

 6.  Edit the title to read Campbell’s Confections and key [your name] as 
the author. Click OK.

 7. Click the Document Information Panel Close button  to close the 
Document Information Panel.

Figure 2-12
Entering Summary 

information

 8. Save the document, and submit your work.

c

Show students how to print 
document properties by opening 
the Print dialog box, and choosing 
Document properties from the Print 
what box.

c Word Classroom 
Presentation 2.

From this point forward in the textbook, 
students will be instructed to “Submit 
your work.” Inform students on your 
procedures for submitting work: printed 
document, e-mail document, or drop box.

You can also view document properties 
in the Open dialog box or the Save As 
dialog box by clicking the Organize 
drop-down arrow.
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Lesson Summary

 Use the Open dialog box to open an existing file. Use the Views button 
 in the dialog box to change the way files are listed.

 Create folders to organize your files. You can do this in the Save As 
dialog box, using the New Folder button . Rename folders by 
locating and selecting the folder. Right-click the folder name and choose 
Rename from the shortcut menu.

 Formatting characters—such as blank spaces or paragraph marks—
appear on-screen, but not in the printed document. Insert a line-break 
character to start a new line within the same paragraph. Insert a 
nonbreaking space between two words to make sure they appear on the 
same line.

 Use the Show/Hide ¶ button  to turn the display of formatting 
characters on and off.

 When a document is larger than the document window, use the 
keyboard or the vertical scroll bar to view different parts of the 
document. Keyboard methods for moving within a document also move 
the insertion point.

 Keyboard techniques for moving within a document include single keys 
(such as  and ) and keyboard combinations (such as � ). 
See Table 2-3.

 Scrolling techniques for moving within a document include clicking the 
up or down scroll arrows on the vertical scroll bar or dragging the scroll 
box. Scrolling does not move the insertion point. See Table 2-4.

 If you make a change in a document that you want to reverse, use the 
Undo command. Use the Redo command to reverse the results of an 
Undo command.

 If you perform an action, such as keying text in a document, and you 
want to repeat that action elsewhere in the document, use the Repeat 
command.

 Selecting text is a basic technique for revising documents. A selection is 
a highlighted block of text you can format, move, copy, delete, or print.

 There are many different techniques for selecting text, using the mouse, 
the keyboard, or a combination of both. Mouse techniques involve 
dragging or clicking. See Table 2-5. Keyboard techniques are listed in 
Table 2-6.

 You can select any amount of contiguous text (characters, words, 
sentences, or paragraphs that follow one another) or noncontiguous text 
(such as words that appear in different parts of a document). Use  
along with the mouse to select noncontiguous blocks of text.

 When text is selected, Word replaces it with any new text you key, or it 
deletes the selection if you press .

Use the Save command to save any revisions you make to a document.

•

•

•

•

•

•

•

•

•

•

•

•

•

•

2

Encourage students to use the 
Lesson Summary to review the 
important concepts in the lesson.
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 Word’s AutoRecover feature periodically saves open documents in the 
background so you can recover a file in the event of a power failure or 
system crash.

 Document properties are details about a file that help identify it. 
Properties include the file name, file size, and date created, which Word 
updates automatically. Other properties you can add or change include 
title, subject, author’s name, and keywords. View or add properties 
for an open document by using the Properties command (File menu, 
Prepare).

•

•

LESSON 2 Command Summary

Feature Button Command Keyboard

Open  File menu, Ctrl � 0  or Ctrl � F12

  Open

Undo Quick Access  Ctrl � Z  or Alt  �
  Toolbar Backspace

Redo Quick Access Ctrl � Y  or 
  Toolbar Alt � Shift � Backspace

Repeat   Ctrl � Y  or F4

Select entire document   Ctrl � A

Save  File menu,  Ctrl � S  or
  Save Shift � F12

Point out that the Command 
Summary lists a variety of ways 
to accomplish a specific task. 
Students can decide which 
method they prefer to use.
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